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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine (Kepler') to provide a real-time visual representation of a data reduction cascade,
called a workflow, which can be easily understood by most astronomers. This document is a tutorial designed
to enable the user to employ the UVES workflow to reduce his/her data in a user-friendly way, concentrating on
high-level issues such as data reduction quality and signal-to-noise (S/N) optimisation.

A workflow accepts science and calibration data, as delivered to PIs in the form of PI-Packs (until October
2011) or downloaded from the archive using the CalSelector tool? and organises them into DataSets, where each
DataSet contains one science object observation (possibly consisting of several science files) and all associated
raw and static calibrations required for a successful data reduction. The data organisation process is fully
automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user for
reduction are fed through the workflow which executes the relevant pipeline recipes (or stages) in the correct
order, providing optional user interactivity at key data reduction points with the aim of enabling the iteration
of certain recipes in order to obtain better results. Full control of the various recipe parameters is available
within the workflow, and the workflow deals automatically with optional recipe inputs via built-in conditional
branches. Additionally, the workflow stores the reduced final data products in a logically organised directory
structure and employing user-configurable file names.

This tutorial deals with the reduction of blue and red arm UVES echelle data for point source observations
only via the UVES Reflex workflow. The user is referred’ to the UVES user manual (Kaufer et al. 2010)
for more information on the instrument itself, and the UVES pipeline user manual (Larsen et al. 2012) for the
details of UVES pipeline recipes. The quick start section (see Section 4) describes the minimum effort to get
started, and it makes up only two pages of this tutorial.

User support for this software is available by sending enquiries to usd-help@eso.org.

"https://kepler-project.org
Zhttp://www.eso.org/sci/archive/calselectorInfo.html
3These documents are available from http://www.eso.org/sci/facilities/paranal/instruments/uves/doc/index.html
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2 Software Installation

The software pre-requisites for Reflex 2.0 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows
To install the Reflex 2.0 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_reflex

2. Make the installation script executable:

chmod u+x install_reflex

3. Execute the installation script:

./install_reflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be given a choice of pipelines to install. Please specify the numbers for the pipelines you require,
separated by a space, or type “A” for all pipelines.

5. To start Reflex, issue the command:
<install dir>/bin/reflex
It may also be desirable to set up an alias command for starting the Re f 1 ex software, using the shell com-

mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.
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3 Demo Data

Together with the pipeline you will also receive a demo data set, that allows you to run the Reflex UVES
workflow without any changes in parameters. This way you have a data set to experiment with before you start
to work on your own data.

Note that you will need a minimum of ~1.2 GB, ~0.9 GB and ~2.3 GB of free disk space for the directories

<download_dir>, <install_dir> and <data_dir>, respectively.

The UVES demo data include five blue arm science observations, and three red arm science observations,
covering a range of signal-to-noise and object types.




Doc: VLT-MAN-ESO-19500-5296
ESO Reflex UVES Tutorial Issue: Issue 3.0
Date: Date 2012-04-05
Page: 9 of 42

4 Quick Start: Reducing The Demo Data

[K] Unname a1 B
File Edit View Workflow Tools Window Help

@emadme=»mmdise

Components | pata | Outline Workflow

Search Components

Figure 4.0.1: The empty Reflex canvas.

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the UVES demo data set supplied with the
Reflex 2.0release. By following these steps, the user should have enough information to attempt a reduction
of his/her own data without any further reading:

1. Start the Re f1ex application:

reflex &

The empty Re f1ex canvas as shown in Figure 4.0.1 will appear.

2. Now open the UVES workflow by clickingon File -> Open, selecting the file
uves—-5.0.3/Uves.xml in the file browser, and clicking Open (this file is located in
<install_dir>/share/reflex/workflows/uves—-5.0.3/Uves.xml in the
pipeline installation). You will be presented with the workflow canvas shown in Figure 4.0.2. Note that
the workflow will appear as a canvas in a new window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (1 ms is recommended), and click .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important direc-
tories (green dots). Setting the value of ROOT_DATA_DIR is the only necessary modification if you want
to process data other than the demo data®, since the value of this parameter specifies the working direc-
tory within which the other directories are organised. Double-click on the parameter ROOT_DATA_DIR

*If you used the install script install_reflex, then the value of the parameter ROOT_DATA_DIR will already be set correctly
to the directory where the demo data was downloaded.
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Figure 4.0.4: The interactive pop-up window for the Spectrum Extraction actor and UVES pipeline
recipe uves_obs_scired. The extracted and merged spectrum for the first DataSet is displayed in the top
panel, and the flux-calibrated spectrum is displayed in the panel below.
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and a pop-up window will appear allowing you to modify the directory string, which you may either edit
directly, or use the button to select the directory from a file browser. When you have finished,

click to save your changes.

5. Click the ||E[ button to start the workflow.

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data direc-
tory (specified by the parameter RAWDATA_DIR under “Setup Directories” in the workflow canvas)
and constructs the DataSets. Note that the calibration and reference data must be present in either
RAW_DATA_DIRorin CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be pro-
cessed.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 4.0.3) that lists the DataSets along with the values of a selection of useful header keywords
including the object name, UVES arm, detector binning and readout speed, instrument grating, and slit
width. The first column consists of a set of tick boxes which allow the user to select the DataSets to be
processed, and by default all DataSets are selected.

8. Click the button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

9. When the workflow has finished executing the final pipeline recipe uves_obs_sciredinthe Spectrum
Extraction actor for the first DataSet, an interactive window will appear (see Figure 4.0.4) which
shows a plot of the extracted and merged spectrum in the top panel, and the flux-calibrated version in the
panel below. Using the buttons at the top of this window, one may pan and zoom in on the spectrum in
order to inspect absorption/emissions lines and other interesting spectral features. Of the other plots in
this window, the most important one is the extracted S/N of the spectrum as a function of the spectral
order as determined from the CCD noise model (and extraction procedure).

10. Click on the ]Continue wk £ \ button and the workflow will write out the important products of the
reduction cascade to the end products directory (specified by the parameter END_PRODUCTS_DIR under
“Setup Directories” in the workflow canvas), which includes the extracted and merged spectrum.

11. The workflow will automatically move on to the next DataSet repeating the reduction cascade and dis-
playing the interactive window with the extracted and merged spectrum. For each DataSet the procedure
is the same; simply inspect the science spectrum and then continue until all DataSets are processed.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data. However, there are many interesting features of Re f 1ex and the UVES workflow that
merit a look at the rest of this tutorial.



Doc: VLT-MAN-ESO-19500-5296
ESO Reflex UVES Tutorial Issue: Issue 3.0
Date: Date 2012-04-05
Page: 13 of 42

5 About The Reflex Canvas

5.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even
if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you
modify a workflow in any way, you have the option of saving the modified version to an XML file using File
-> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved
workflow may be opened in subsequent Re f1ex sessions using File —> Open.

5.2 Buttons

At the top of the Ref1ex canvas are a set of buttons which have the following useful functions:

° @ - Zoom in.

° @‘ - Reset the zoom to 100%.

° - Zoom the workflow to fit the current window size (Recommended).
° @ - Zoom out.

) |BI - Run (or resume) the workflow.

° @ - Pause the workflow execution.

° @ - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

5.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the

yellow highlighting of the ||E[ ’E and @ buttons, respectively. A workflow is executed by clicking the |BI
button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the

@ button, or the workflow may be paused by clicking the [T button which will allow the current actor/recipe

to finish execution before the workflow is actually paused. Note that after clicking the [T button, it is possible
that more than one actor is executed, since this behaviour depends on the workflow scheduling. For instance, if
there are two actors in parallel, and you pause the workflow while one is being executed, then both of them will
be executed before the workflow is actually paused. After pausing, the workflow may be resumed by clicking

the ”E[ button again.
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5.4 The Runtime Window

You may find the runtime window a useful aid in monitoring the reduction progress of your data. This window
may be started by clicking Workflow —> Runtime Window from the Reflex canvas menu. You will
notice that on the left-hand side the runtime window has buttons allowing the control of the workflow (,
[Pause|, [Resume], | Stop|) and text boxes for controlling workflow parameters such as the working data
directory etc.

On the right-hand side of the runtime window is a text box with the title “Recipe Status” which lists the current
status of each pipeline recipe and the reduction status of each DataSet. A recipe may have the following status
values:

e Not Running - The recipe has not yet been run for any DataSet so far.

e Executing - The recipe is currently executing for a DataSet.

Done - The last execution of the pipeline recipe was successful.

Failed - The recipe failed on the last DataSet.

Skip - The recipe was skipped for the last DataSet.
e Disabled - The recipe was disabled for the last DataSet.

e Stopped - The workflow was stopped during the reduction of a DataSet.

Below the list of recipe status values is a detailed list of input and output files used for each DataSet within each
recipe execution. This information is sometimes very useful for the user who wants to know exactly which files
were used as input for a particular DataSet for a given pipeline recipe, and where the relevant output files were
written.
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6 The UVES Workflow

The UVES workflow canvas is organised into a number of areas (see Figure 4.0.2). From top-left to top-right
you will find general workflow instructions, directory parameters, and global parameters. In the middle row you
will find five green boxes describing the workflow general processing steps in order from left to right, and below
this the workflow actors themselves are organised as per the workflow general steps.

6.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user (see Figure 4.0.2). Un-
der “Setup Directories” the user is only required to set the ROOT_DATA_DIR to the working directory for
the DataSet(s) to be reduced, which, by default, is set to the directory containing the demo data. Raw data
should be stored in a subdirectory of ROOT_DATA_DIR, defined by the parameter RAWDATA_DIR, which is
recursively scanned by the Data Organiser actor for input raw data. The directory CALIB_DATA_DIR,
which is within the pipeline installation directory, is also scanned by the Data Organiser actor to find
any static calibrations that may be missing in your DataSet(s). If required, the user may edit the directories
BOOKKEEPING_DIR, LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond
to the directories where book-keeping files, logs, temporary products and end products are stored, respectively
(see the Reflex User Manual for further details; Forchi 2012).

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to
the command used for running his/her favourite application for inspecting FITS files. Currently this is set by
default to £v, but other applications, such as ds 9, skycat and gaia for example, may be useful for inspecting
image data.

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before
executing the workflow, and the recipe actors will work in Lazy mode (see Section 6.2.4), reusing the previous
pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves
considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to t rue, which
forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR,
LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will
force the workflow to fully rereduce the data each time the workflow is run.

The remaining two global parameters are set automatically by the workflow itself and should not be modified.

6.2 Workflow Actors

6.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They
may also have a logo within the rectangle to aid in their identification. The following actors are simple actors:

DataOrganizer

datasets out

° - The Data Organiser actor.
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° -The Data Set Chooser actor.

Product Renamer

DataFilter
sof out

sof rojected

The Fits Router actor

- The Product Renamer actor.

-The Data Filter actor.

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window (see Figure 6.2.5). Note that the Product Renamer
actor is a jython script (Java implementation of the Python interpreter) meant to be customized by the user (by
double-clicking on it).

6.2.2 Composite Actors

Composite actors have workflow symbols that consist of multiply-layered green-blue rectangles. They generally
do not have a logo within the rectangle. A composite actor represents a combination of more simple or composite
actors which hides over-complexity from the user in the top-level workflow. A yellow box marks an actor with
an associated interactive window. In the UVES workflow, the following actors are composite actors:

Initialise

-The Initialise actor.

-The Display Current DataSet actor.

- The Master Bias Creation actor.

" _The Master Dark Creation actor.

[
LS
Display Current Dataget
[ ]
Master Bias Creation
[ ]
Master Dark Creation
masterc
[ ]
Master Flat Craator
[

Spectrum Locator

-The Master Flat Creation actor.

° .I - The Spectrum Locator actor.

Order Detertign
. i' - The Order Detection actor.
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Wavelength Calibratior

° -h - The Wavelength Calibration actor.

Instrument Response

° -h - The Instrument Response actor.

Spectrum Extractior

° ! - The Spectrum Extraction actor.
CIoiDatBSel
-The Close DataSet actor.

Access to the parameters for a composite actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window (see Figure 6.2.1).

Edit parameters for Spectrum Extraction

class; [ptoIemy.actor.TypedCompositeActor

semanticType00: | urnilsid:localhost:onto:1:1#Actor

semanticTypell: | urn:lsid:localhost:onto:2:1#GeneralPurpose

|

|

|

semanticType22: |urn:Isid:localhost:0nt0:2:1#W0rk‘FIow |
Enablelnteractivity: |true |
INIT_EXTRACT_METHOD: [optimal |
INIT_EXTRACT_KAPPA: 10.0 |
INIT_EXTRACT_PROFILE: lauto |
INIT_EXTRACT_SKYMETHOD: optimal |
INIT_EXTRACT_OWERSAMPLE: | 1 |
INIT_SLITLENGTH: 10 |
INIT_OBJOFFSET: 0.0 |
INIT_REBIN_WAVESTEP: 10 |
derivedFrom: |_49:1:urn:|sid:kepler—project.orgfnsf:5968:??:19:urn:|sid:kepler—project.orgfnsf:10?33:21:25.|
Cancel | | Help | | Preferences | |Restore Defaults| | Remove | | Add | [ Commit l

Figure 6.2.1: The “Edit parameters” window for a typical composite actor..

Composite actors may also be expanded for inspection. To do this, right-click on the actor and select Open
Actor, which will expand the composite actor components in a new Re £ 1ex canvas window. If the composite
actor corresponds to a pipeline recipe, then the corresponding recipe executer actor will be present as a simple
actor, and its parameters are accessible as for any other simple actor. Alternatively you may still find composite
actors, on which you need to repeat the first step to access the recipe executer.
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Figure 6.2.2: This is the window you get when you choose Open Actor for the composite actor Master
Bias Creation. This is the most simple case of a composite actor in the UVES workflow.

6.2.3 Recipe Execution within Composite Actors

The UVES workflow contains composite actors to run the pipeline recipes. This is in the most simple case
due to the SOF Splitter/Accumulator?, which allows to process calibration data from different settings
within one given DataSet (e.g. bias frames with different binnings, dark frames with different DIT, etc.). More
complex composite actors contain several actors.

The central elements of any Reflex workflow are the Recipe Executer actors that actually run the recipes.
One basic way to embed a Recipe Executer in a workflow is shown in Figure 6.2.2, which is the most
simple version of a composite actor in the UVES workflow. The Recipe Executer is preceded by an
SofSplitter, and followed by an SofAccumulator. The function of the SofSplitter is to inves-
tigate the incoming SoFs, sort them by “purpose”, and create separate SoFs for each purpose. The Recipe
Executer then processes each of the SoFs independently. Finally, the SofAccumulator packs all the re-
sults into a single output SoF. The direct relation between the SofSplitter and SofAccumulator is used
to communicate the number of different SoFs created by the SofSplitter. A workflow will only work as
intended if the purpose of all the files a recipe needs as input is identical. The only exception to this rule is that a
purpose can also be “default”. In this case, the file is included in any output SoF created by the SofSplitter
and SofAccumulator.

The reason for this scheme is best explained by an example. For a complex DataSet, the Data Organiser
might have selected a large number of individual raw bias frames. The different bias frames are to be used to
de-bias different frames, e.g. the science frames, the various arc lamp and flat field frames and the standard star
frames. The Data Organiser determines and records this “purpose” of each bias, and this information is
included in the DataSet and each SoF created from this DataSet. The Fit sRouter directs all raw biases to the
Master Bias Creation composite actor. The SofSplitter then creates SoFs, one for the biases to be
used for the science images, and (possibly) separate ones for the biases to be used for the calibration images and
flat fields. The uves_cal_mbias recipe creates one master bias for each SoF, and the SoAccumulator
then creates a SoF that contains all the master biases.

A Recipe Executer actor is used in the workflow to run a single UVES pipeline recipe (e.g: the “Master
Bias Creation™ actor runs the uves_cal_mbias pipeline recipe). In order to configure a recipe executer,
one has to first use Open Actor (possibly repeatedly) to get to the level of the recipe executers (see Fig-
ures 6.2.3 & 6.2.4).

3SoF stands for Set of Files, which is an ASCII file containing the name (and path) of each input file and its category (e.g.
BIAS_UVB)
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Figure 6.2.3: The window you get when you choose Open Actor for the composite actor Master Flat
Creation. Using Open Actor onMaster Flat Creation gives you Figure 6.2.4.

uves_cal_mflat_1

sof in SofSplit s ~ SofAccumulator g o

Figure 6.2.4: This is the window you get when you choose Open Actor for the composite actor Master
Flat Creation withinMaster Flat Creator.

In Figure 6.2.5 we show the “Edit parameters” window for a typical recipe executer actor, which can be dis-
played by right-clicking on the actor and selecting Configure Actor. In the following we describe in more
detail the function of some of the parameters for a recipe executer actor:

e The “recipe” parameter states the UVES pipeline recipe which will be executed.

e The “mode” parameter has a pull-down menu allowing the user to specify the execution mode of the actor.
The available options are:

— Run: The pipeline recipe will be executed, possibly in Lazy mode (see Section 6.2.4). This option
is the default option.
— Skip: The pipeline recipe is not executed, and the actor inputs are passed to the actor outputs.

— Disabled: The pipeline recipe is not executed, and the actor inputs are not passed to the actor
outputs.
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recipe: uves_cal_mbias

mode: Run El
Lazy Mode:

Recipe Failure Mode: $RecipeFailureMode hd
Input Files Tag: [

Output Files Tag: [

File Purpose Processing: Strip last EI
Allow empty inputs: O

Pause before execution: O

Pause after execution: O

Clear Products Dir: Never -
Clear Logs Dir: Never e
Clear Bookkeeping Dir: Never -
Products Dir: $TMP_PRODUCTS_DIR Browse
Logs Dir: $LOGS_DIR Browse
Bookkeeping Dir: $BOOKKEEPING_DIR Browse
EsoRex default args: $ESORexArgs

recipe_param_1: debug=FALSE

recipe_param_2: plotter=no

recipe_param_3:
recipe_param_4:
recipe_param_5:

process_chip=both

clean_traps=TRUE

stack_method=median

recipe_param_6: klow=5.0
recipe_param_7: khigh=5.0
recipe_param_8: niter=5
Reuse Inputs (Expert Mode): O
Reuse Outputs (Expert Mode): O
Commit | | Add | | Remove | | Restore Defaults | | Preferences | ‘ Help | | Cancel

Figure 6.2.5: The “Edit parameters” window for a typical recipe executer actor, the uves_cal_mbias actor
which runs the uves_cal_mbias pipeline recipe.

e The “Lazy Mode” parameter has a tick-box (selected by default) which indicates whether the recipe

executer actor will run in Lazy mode or not. A full description of Lazy mode is provided in the next
section.

The “Recipe Failure Mode” parameter has a pull-down menu allowing the user to specify the behaviour
of the actor if the pipeline recipe fails. The available options are:

— Stop: The actor issues an error message and the workflow stops.
— Continue: The actor creates an empty output and the workflow continues.

— Ask: The actor displays a pop-up window and asks the user whether he/she wants to continue or
stop the workflow. This is the default option.

The set of parameters, which start with “recipe_param_" and end with a number, corresponds to the
parameters of the relevant UVES pipeline recipe. By default in the recipe executer actor, the pipeline
recipe parameters are set to their pipeline default values. If you need to change the default parameter
value for any pipeline recipe, then this is where you should edit the value. For more information on the
UVES pipeline recipe parameters, the user should refer to the UVES pipeline user manual (Larsen et al.
20129).

® Available from http://www.eso.org/sci/facilities/paranal/instruments/uves/doc/index.html
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The description of the remainder of the recipe executer actor parameters are outside the scope of this tutorial,
and the interested user is referred to the Reflex User Manual for further details (Forchi 2012). Any changes
that you make in the “Edit parameters” window may be saved in the workflow by clicking the button
when you have finished.

6.2.4 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when
the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has
already been executed with the same input files and with the same recipe parameters. If this is the case, then the
actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products
to the output port. The purpose of the Lazy mode is therefore to minimise any reprocessing of data by avoiding
data rereduction where it is not necessary.

One should note that the actor Lazy mode depends on the contents of the directory specified by
BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or
the file checksums will cause the corresponding actor when executed to run the pipeline recipe again, thereby
rereducing the input data.

The forced rereduction of data at each execution may of course be desirable. To force a rereduction of all data
for all RecipeExecuter actors in the workflow (i.e. to disable Lazy mode for the whole workflow), set the
EraseDirs parameter under the “Global Parameters” area of the workflow canvas to t rue. This will then
remove all previous results as well. To force a rereduction of data for any single RecipeExecuter actor
in the workflow (which will be inside the relevant composite actor), right-click the RecipeExecuter actor,
select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window
that is displayed.

6.3 Workflow Steps

6.3.1 Step 1: Data Organisation And Selection

On clicking the ||E[ button on the Re f1ex canvas, the workflow will highlight and execute the Initialise
actor, which among other things will clear any previous reductions if required by the user (see Section 6.1).

1. The DataOrganiser (DO) is the first crucial component of a Reflex workflow. The DO takes as
input RAWDATA_DIR and CALIB_DATA_DIR and it detects, classifies, and organises the files in these
directories and any subdirectories. The output of the DO is a list of “Data Sets”. A DataSet is a special Set
of Files (SoF). A DataSet contains one or several science (or calibration) files that should be processed
together, and all files needed to process these data. This includes any calibration files, and in turn files
that are needed to process these calibrations. Note that different DataSets might overlap, i.e. some files
might be included in more than one DataSet.

A DataSet lists three different pieces of information for each of its files, namely 1) the file name (includ-
ing the path), 2) the file category, and 3) a string that is called the “purpose” of the file. The DO uses
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OCA rules to find the files to include in a DataSet, as well as their categories and purposes. The file
category identifies different types of files. A cateogry could for example be FLAT_BLUE, DARK_RED,
or SCIENCE_BLUE. The purpose of a file identifies the reason why a file is included in a DataSet.
The syntax is action_1/action_2/action_3/ ... /action_n, where each action_i
describes an intended processing step for this file. The actions are defined in the OCA rules and con-
tain the recipe together with all file categories required to execute it (and predicted products in case of
calibration data). For example, a workflow might include two actions ACTION_MASTER_BIAS_BLUE
and ACTION_EFLAT_ECH_BLUE. The former creates a master bias from raw biases, and the latter
creates a master flat from raw flats. The ACTION_EFLAT ECH_BLUE action needs raw flats and the
master bias as input. In this case the biases will have the purpose ACTION_MASTER_BIAS_BLUE/
ACTION_EFLAT_ECH_BLUE. The same DataSet might also include biases with a different purpose,
e.g. ACTION_MASTER_BIAS_BLUE/ACTION_MASTER_DARK_BLUE. Irrespective of their pur-
pose the file category for all these biases will be BIAS_BLUE.

TODO: Break the lines above

. Next the Data Set Chooser displays the available DataSets in the “Select Datasets” window®, acti-
vating a vertical scroll bar on the right if necessary (see Figure 4.0.3). Sometimes you will want to reduce
a subset of these DataSets rather than all DataSets, and for this you may individually select (or de-select)
DataSets for processing using the tick boxes in the first column, and the buttons ] Select All \ and

|Deselect All]atthe bottom left.

You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click
on’ Inspect Highlighted ‘, then a “Select Frames” window will appear that lists the set of files that
make up the highlighted DataSet including the full filename and path for each file, the file category (from
the FITS header), and a selection tick box in the first column (see Figure 6.3.1). The tick boxes allow you
to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of
poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as

an ASCIT file by clicking on and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will
be highlighted in blue, and the file FITS header will be displayed in the text box on the right (see Fig-
ure 6.3.1), allowing a quick inspection of useful header keywords. If you then click on , the
workflow will open the file in the selected FITS viewer application defined by the workflow parameter
FITS_VIEWER.

To exit from the “Select Frames” window, click , and to exit from the “Select Datasets”

window, click either in order to continue with the workflow reduction, or in order

to stop the workflow.

The categories and purposes of raw files are set by the DO, whereas the categories and purpose of products
generated by recipes are set by the Recipe Executer (see Sect. 6.2.3). The file tags are used by the
FitsRouter to send files to particular processing steps or branches of the workflow (see below). The purpose

"OCA stands for OrganisationClassificationAssociation and refers to rules, which allow to classify the raw data according to the
contents of the header keywords, organise them in appropriate groups for processing, and asscociate the required calibration data for
processing. They can be found in the directory <install_dir>/share/esopipes/<pipeline-version>/reflex/,
carrying the extension. oca

81f you run the Data Organiser in Lazy Mode, changes in the Keywords to be displayed list will have no effect on
the output shown in the Data Set Chooser.
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is used by the SofSplitter and SofAccumulator to generate input SoFs for the Recipe Executer.
Note that while the DO includes files into a DataSet for a reason, and records this reason as the “purpose” of the
file, the workflow itself can use these files in a different manner. The SofSplitter and SofAccumulator
accept several SoFs as simultaneous input. The SofAccumultor creates a single output SoF from the inputs,
whereas the SofSplitter creates a separate output SoF for each purpose.

[y
Selected Data Set #Files QBJECT|
v] UVES.2009-01 21T03:41,58,063 126 HED932-0346
v/ UVES.2009-04-05T09:4347,822 126 HR7355
v] UVES.2009-03-13T04;00;31 835 126|Hen-3-847
v UVES.2009-02-13T00,57:58,546 157 [RN-LMC-2009
v] UVES.2009-02-04T00:47:11,636 126051624.60-69
= UVES.2009-03-20T05/05/09,533 95[LTT-4816
= UVES.2008-10-26T00;24:47,790 125/95gr
v] UVES.2009-04-12T23,55 41,635 127 |PG-0934+145
v UVES.2009-03-11T07:30:35,949 95[1ES-1553+113
(£}
Keyword Va
[} UVES.2009-01-21T03:41:58.063.fits SIMPLE T -
[} UV_GMRE_0410134_master_response_BLUE437.fits BITPIX 16
[ UV_GEXT_031013A extcoeff tablefits AX15 2 =
7 [ ORDERDEF_ECH_BLUE mx:g; 1233
[ UVES.2009-01-21T1 3115137, 643.fits EXTEND T u
¢ 3 BIAS_BLUE FCOUNT 5
[} UVES.2009-01-21T12:12:23.171 fits GCOUNT T
[ UVES.2009-01-21T12:13111,585.fits BZERO 32768.0
[} UVES.2009-01-21T12:13:59.999.fits BSCALE 1.0
[} UVES.2009-01-21T12:14:48.403 fits ORIGIN EsO
4] 1 \ [ UVES.2009-01-21T12/15: 36,806, fits ?éLT;scop Eggg\ﬁjgnm
| selectan | peselectall | saw | o CIFMTCHK ECH BLUE STRUME vES
o [ WAVE_ECH_BLUE OBIECT ETS
|: o ] BIAS_BLUE RA 176.023050
& [ DARK_BLUE DEC 1003846
" | o [ EFLAT_ECH_BLUE EQUINOX 2000,
RADECSYS FKS
EXPTIME 0.0000
MID-0BS 5485250860152,
DATE-OBS 2009-01-21T12:1
uTC 43931,000
LST 56072.803
PI-COI UVES Operation 1]
OBSERVER
CTYPEL PIXEL
CTYPEZ PIXEL =
4] Il | I K I \ I¥]
Select All Deselect All ‘ ‘ Save as... ‘ Inspect |

Figure 6.3.1: The “Select Frames” window with a single file from the current DataSet highlighted in blue,
and the corresponding FITS header displayed in the text box on the right. Hidden partially behind the “Select
Frames” window is the “Select Datasets” window with the currently selected DataSet highlighted in blue.

6.3.2 Step 2: Creation Of Master Calibration Files

In this step of the workflow, the following UVES recipes are executed in the order listed below. Please refer to
the UVES pipeline user manual (Larsen et al. 2012: Sections 9, 10 & 11) for the details of each recipe and the
algorithms employed:

1. The Master Bias Creation actor will execute the UVES pipeline recipe uves_cal_mbias in
order to create a combined master bias frame from the set of raw bias frames.
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2. The Master Dark Creation actor will execute the UVES pipeline recipe uves_cal_mdark in
order to create a combined master dark frame from the set of raw dark frames. Note that this actor will be
skipped if there are no raw dark frames in the current DataSet.

3. The Spectrum Locator actor will execute the UVES pipeline recipe uves_cal_predict in order
to compute initial guesses for the wavelength solution and order positions by employing a physical model
of UVES combined with the information on the atmospheric pressure, temperature, and corresponding
instrument setting stored in the FITS header of the input arc-lamp frame.

4. The Order Detection actor will execute the UVES pipeline recipe uves_cal_orderpos in order
to fully detect and define the order positions on the detector from an input flat-field frame.

5. The Master Flat Creation actor will execute the UVES pipeline recipe uves_cal_mflat in
order to create a combined master flat frame from the set of raw flat frames.

Note that the workflow supports the processing of deuterium lamp flats (DPR TYPE = LAMP,DFLAT)
in addition to the usual lamp flats (DPR TYPE = LAMP, FLAT). The deuterium lamp flats are recom-
mended for the spectral region shortwards of 350 nm and they are taken as supplementary calibrations for
the UVES blue arm central wavelength setting of 346 nm. If deuterium flats are present in the DataSet,
then they will be combined with the usual lamp flats into a combined master flat that provides much better
S/N shortwards of 350 nm.

6.3.3 Step 3: Wavelength And Response Calibration

In this step of the workflow, the following UVES recipes are executed in the order listed below. Please refer to
the UVES pipeline user manual (Larsen et al. 2012: Sections 9, 10 & 11) for the details of each recipe and the
algorithms employed:

1. The Wavelength Calibration actor will execute the UVES pipeline recipe
uves_cal_wavecal inorder to create a wavelength calibration solution from an input arc-lamp frame.

2. The Instrument Response actor will execute the UVES pipeline recipe uves_cal_response
in order to create an instrument response curve from the observation of a standard star, which will subse-
quently be used to flux-calibrate the science observation. Note that this actor will be skipped if there are
no observations of a standard star in the current DataSet.

One should also note that a standard star observation is only included in the DataSet for a science observation
if it was taken on the same night. Generally, UVES data are supplied with master instrument response curves
which will also be included in the DataSets for a science observation. The UVES workflow will flux-calibrate
the science observation using the instrument response curve derived from the standard star observation if it
exists in the current DataSet, and failing this, the master instrument response curve will be used if it exists in
the current DataSet. If neither a standard star observation nor a master instrument response curve exist in the
current DataSet, then the science observation will not be flux-calibrated.
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6.3.4 Step 4: Spectrum Extraction

In this step of the workflow, the Spectrum Extraction actor will execute the UVES pipeline recipe
uves_obs_scired in order to extract and merge the science spectrum from the science observation. Please
refer to the UVES pipeline user manual (Larsen et al. 2012: Sections 9, 10 & 11) for the details of this recipe
and the extraction algorithms employed. As described in the previous section, the flux-calibration of the science
spectrum will be carried out if an appropriate instrument response curve (master or otherwise) has been used as
an input to this actor.

After the spectrum extraction, the actor will display an interactive window to allow the user to inspect the
extracted spectrum and assess the extraction quality (see Figure 4.0.4).

6.3.5 Step 5: Output Organisation

After having processed the input data for a DataSet, the Data Filter actor allows the user to inspect the
results and select which files to save. By default this actor is set to skip and all products will be saved. Next the
workflow highlights and executes the Product Renamer actor, which, by default, will copy the defined final
products of the UVES pipeline recipe uves_obs_scired to the directory specified by END_PRODUCTS_DIR
and rename them with names derived from the values of certain FITS header keywords. Specifically, final prod-
ucts are renamed by default with names of the form:

HIERARCH.ESO.OBS.NAME_HIERARCH.ESO.PRO.CATG.fits

where <HIERARCH.ESO.OBS.NAME> and <HIERARCH.ESO.PRO.CATG> represent the values of the cor-
responding FITS header keywords. These names are fully configurable by right-clicking on the Product
Renamer actor and selecting Configure Actor, and then editing the Rename_keywords parameter as
appropriate.

The final products that are copied and renamed are:

e <HIERARCH.ESO.OBS.NAME>_RED_SCI_POINT_<ARM>.fits - The extracted and merged sci-
ence spectrum.

e <HIERARCH.ESO.OBS.NAME>_ERRORBAR_SCI_POINT_<ARM>.fits - The uncertainty on the
extracted and merged science spectrum.

e <HIERARCH.ESO.OBS.NAME>_ FLUXCAL_SCI_POINT_<ARM>.fits - The extracted, merged,
and flux-calibrated science spectrum. This product is only generated if an appropriate instrument re-
sponse curve (master or otherwise) was used as an input to the Spectrum Extraction actor.

e <HIERARCH.ESO.OBS.NAME>_FLUXCAL_ERRORBAR_SCI_POINT_<ARM>.fits - The uncer-
tainty on the extracted, merged, and flux-calibrated science spectrum. This product is only generated if
an appropriate instrument response curve (master or otherwise) was used as an input to the Spectrum
Extraction actor.

e <HIERARCH.ESO.OBS.NAME>_ ORDER_EXTRACT_QC_<ARM>.fits - A table of useful statistics
from the spectrum extraction procedure which are used to make the plots in the interactive window for
the Spectrum Extraction actor (see Figure 4.0.4).
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The remaining actors in this step of the workflow are concerned with the termination of the data flow for the
current DataSet and will highlight briefly as they are executed.
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Figure 6.3.2: The interactive window for the Spectrum Locator actor for the first DataSet in the data
supplied with Reflex 2.0..
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Figure 6.3.3: Same as Figure 6.3.2 but after iteration of the corresponding uves_cal_predict pipeline
recipe.
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7 Optimising Your Results Through Workflow Interaction

In this section, we use the information from Sections 5 & 6 along with the UVES demo data supplied with
Reflex 2.0 toillustrate how to optimise the scientific products in terms of quality and S/N. This is achieved
by interaction with the workflow actors via interactive windows displayed at key data reduction points in the
data flow, which enable iteration of certain recipes in order to obtain better results. For instance, the physical
model prediction calculated during execution of the Spectrum Locator actor may be inaccurate and need
correcting, or the wavelength solution may need tweaking, or the user may want to clip more cosmic rays from
the extracted spectrum.

We recommend that the user has already carried out the reductions for all the data sets as described in Section 4,
although this is not a pre-requisite to following this section. By doing this, the user will be taking advantage of
the workflow Lazy mode, with minimal waiting time between various pipeline recipe executions.

Please notice that the numbers given in the rest of the section where obtained in a Fedora 14 32 bit machine.
Your values may differ slightly depending on you operating system and platform.

Please follow these steps in order to optimise the reductions for the UVES demo data supplied with Reflex
2.0:

1. Carry out the first four steps described in the quick start Section 4.

2. Inthe UVES workflow, the four interactive actors (Spectrum Locator,Wavelength Calibration,
Instrument Response, Spectrum Extraction) are identifiable by a yellow rectangle encom-
passing the actor name. For all of these composite actors except the Spectrum Extraction actor,
you will need to enable their interactive mode. Do this by double-clicking on the composite actor, setting
the “Enablelnteractivity” parameter to t rue, and clicking to save the changes to the workflow.

3. Click the ||E[ button.

4. Click the button in the “Select Datasets” window.

5. Spectrum Locator: During the execution of the Spectrum Locator actor, an interactive win-
dow will appear as shown in Figure 6.3.2. The interactive window consists of six plots, five pipeline
recipe parameters that may be changed, four buttons on the right, and a panel of buttons at the top-left.
Help for each of these features may be accessed by leaving the mouse pointer for about one second over
the plot/parameter/button for which information is required.

The Spectrum Locator actor executes the UVES pipeline recipe uves_cal_predict, taking as
input a format-check arc-lamp frame. The purpose of the recipe is to compute an initial guess for the
wavelength solution and order positions by employing a physical model of UVES combined with the
information on the atmospheric pressure, temperature, and corresponding instrument setting in the FITS
header of the input arc-lamp frame. For quality control purposes, this initial guess wavelength solution
may be compared with the actual detected line positions (shown in the bottom-right plot), which also
allows the identification of cases where the physical model prediction is inaccurate.

The plots in the interactive window provide such a comparison by showing the differences XDIF and
YDIF between the predicted and detected line positions along the = and y image axes, respectively, as
functions of x, y and each other. If the physical model prediction is good, then these plots will show clear
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trends with sets of scattered outliers, and the statistics shown in the plot titles should report median values
for XDIF and YDIF that are in the range £ 10 pix. If the physical model prediction is poor, then these
plots will show only scattered points with no trends, although this happens very rarely (e.g. for data taken
after an earthquake event).

. The panel of buttons at the top-left of the interactive window may be used to manipulate the displayed
plots. The buttons have the following functions:

o T _Resetall the plot ranges to their original values.
e © _ Undo the last modification of the plot ranges (if possible).
o © _Redo the next modification of the plot ranges (if possible).

. - Selecting this button allows the user to use the mouse to shift the plot ranges by left-clicking

+ _ Selecting this b 11 h h hift the pl by left-clicki
on the target plot canvas and then dragging the mouse around while keeping the left mouse button
held down, and releasing when ready.

e ° - Selecting this button allows the user to zoom in on each plot by left-clicking on the target plot
canvas to mark the top-left corner of a rectangle and then dragging the mouse to the bottom-right
corner of the rectangle and releasing. The plot ranges will then be modified to match the rectangle
that was defined. The following constraints can be made by holding simultaneously a key while
pressing the left mouse button:

Constrain pan/zoom to x axis hold E
Constrain pan/zoom to y axis hold E
Preserve aspect ratio hold @

o B Clicking this button opens a “Configure subplots” window that allows the user to adjust the
spacing and positioning of the individual plots.

o @ _ Clicking this button opens a “Save to file” window which allows the user to save a screenshot
of the current interactive window.

Use these buttons to inspect the plots in the interactive window in more detail.

. In some cases it is worth adjusting the initial guess wavelength solution to better match the detected
line positions in order for the subsequent wavelength calibration recipe to produce a more robust (and
possibly better) wavelength solution, especially if the median XDIF and/or YDIF values are outside
the range £ 5 pix. This may be done by adding the median XDIF and YDIF values to the values in
the text boxes corresponding to the pipeline recipe parameters trans_x and trans_y, respectively,
on the right-hand side of the interactive window, and then clicking the Re-run recipe button. The
uves_cal_predict pipeline recipe will be executed again with the new parameter values, and the
new results will appear in the interactive window. This time the median XDIF and YDIF values should
be closer to zero, and the corresponding root-mean-square (RMS) values will most likely have decreased.
The adjustment of the t rans_x and t rans_y parameters may be iterated until the median XDIF and
YDIF values are in the range + 0.1 pix (usually two or three iterations are required).

Carry out this procedure for the current DataSet. The first values for trans_x and trans_y should be
-1.62 and 11.00 pix respectively for this DataSet, with RMS statistics of 6.41 and 3.90 pix for XDIF and
YDIF respectively. Further iteration should converge to values of ~-1.69 and ~11.27 pix for trans_x
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and trans_y respectively, with RMS statistics of 6.27 and 2.99 pix for XDIF and YDIF respectively.
At this point, the interactive window should look like the one shown in Figure 6.3.3.

. Before we move on, we note that there are three other pipeline recipe parameters on the right-hand side
of the current interactive window. The parameters mbox_x and mbox_y are used to define a search
box for matching the physical model line positions with the positions of the lines detected in the input
arc-lamp frame. If the physical model prediction is poor, as shown by the lack of clear trends in the
plots in the interactive window, then one should try larger values of mbox_x and mbox_y, such as 60
or 80 pix, in order to aid the uves_cal_predict recipe in determining the initial guess wavelength
solution. Subsequent adjustment of t rans_x and t rans_y should then be performed (as described in
the previous step), and then mbox_ x and mbox_y should be set back to 40 pix, and one final adjustment
of trans_x and trans_y should be performed to arrive at the best initial guess wavelength solution.

The parameter ccd_rot_angle_off may be used to help “tighten” any less-well defined trends in the
plots in the interactive window. This adjustment is usually not necessary, but if it is, then rotations of the
order of 0.01-0.1 in either sense may make improvements.

. Click the Continue wkf button in the interactive window, and practice optimising the initial guess
wavelength solution on the remaining format-check arc-lamp frames. Note that this window will appear
several times, one for each use of the wavelength calibration, even if they are the same files. This will be
solved in future releases.
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Figure 7.0.4: The interactive window for the Wavelength Calibration actor for the first DataSet in the
data supplied with Reflex 2.0.

10. Wavelength Calibration: The nextinteractive window that will appear (see Figure 7.0.4) is asso-
ciated with the execution of the Wavelength Calibration actor, which executes the UVES pipeline
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Figure 7.0.5: Same as Fig. 7.0.4 but after iteration of the corresponding uves_cal_wavecal pipeline
recipe..
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11.

recipe uves_cal_wavecal. This pipeline recipe determines the wavelength calibration solution from
an appropriate arc-lamp frame and a line reference catalogue. The top two plots in the interactive win-
dow show the wavelength calibration residuals for arc lines that were identified in the input line reference
catalogue as a function of wavelength and spectral order. Blue points represent arc lines that were used
in the final solution, and red points represent arc lines that were excluded from the final solution. The
bottom-left plot shows the arc line FWHM as a function of wavelength, and the bottom-right plot displays
the positions of all detected arc lines on the detector.

The wavelength calibration solutions produced by the UVES pipeline are generally robust and of good
quality, showing very few systematic errors in the wavelength residuals and demonstrating the correct
identification and clipping of outliers. The main purpose of this interactive window is therefore to allow
the user to check that all is well with the wavelength solution, and to allow some further refinement if so re-
quired. Most users will simply accept the solution that is presented by clicking on the ’ Continue wkf ‘
button.

The interactive window gives access to seven pipeline recipe parameters that may be adjusted in order to
improve the wavelength calibration solution, where an improvement is characterised by a smaller RMS
statistic for the wavelength residuals (reported in the upper plot titles) but with a reasonable number of
arc lines used in the final solution (reported as “Final no. of fitted lines”). We suggest that you attempt
to improve the wavelength calibration solution for the first DataSet, based on the parameter descriptions
that follow:

e range - Twice the value of this parameter is the window width used for arc line detection (pix). Ad-
justing this parameter will influence the number of arc lines that are detected. Varying this parameter
in the range 4-12 pix is sometimes useful for optimising the number of detected arc lines.

e minlines - The minimum number of arc lines to be detected. This parameter should only be
adjusted in conjunction with the parameter maxlines. Adjusting this parameter will force the
pipeline recipe to find a minimum number of arc lines, if possible. This parameter is useful for
controlling the number of lines used in the wavelength calibration solution.

e maxlines - The maximum number of arc lines to be detected. This parameter should only be
adjusted in conjunction with the parameter minlines. Adjusting this parameter will force a max-
imum on the number of arc lines the pipeline recipe finds. This parameter is useful for controlling
the number of lines used in the wavelength calibration solution.

e alpha - This parameter ranges from 0.0 to 1.0, and is used to control the line matches between
the detected arc lines and those in the reference line catalogue by rejecting line matches where
the distance to the next nearest neighbour (in the spectrum aswell as in the catalogue) is smaller
than A)/alpha, where A\ is the wavelength residual for the current line match candidate. This
parameter is best adjusted in conjunction with the parameter tolerance. Adjusting alpha in the
range ~0.03-0.3 is useful for controlling the number of line identifications and hence the number of
lines used in the wavelength calibration solution.

e degree - The degree of the polynomial model to be used in the wavelength calibration process.
Usually the default value of 4 gives acceptable wavelength residuals with no systematics, but some-
times higher degrees such as 5 or 6 give better results. It is also worth trying the value -1, which
instructs the pipeline recipe to determine the model degree based on the wavelength residuals.

e tolerance - This parameter is used to reject line identifications with wavelength residuals worse
than tolerance from the wavelength calibration solution. This parameter is best adjusted in
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conjunction with the parameter alpha. Varying tolerance in the range 0.1-1.0 is sometimes
useful for optimising the number of lines used in the wavelength calibration solution.

e kappa - The level of sigma-clipping to be performed in the final iterations of the fit of the wave-
length calibration model. Suggested values for this parameter are in the range 3.0-5.0.

We find that for the first DataSet, setting degree = -1 and leaving the other parameters at their default
values, is sufficient to reduce the RMS of the residuals from 1.89x 1073 to 1.71x10~2 Ang while only
reducing the final number of fitted lines from 1142 to 1140 (see Figure 7.0.5).

12. Click the ’ Continue wkf |button in the interactive window.

13. Instrument Response: The standard DataSets supplied with Reflex 2.0 do not include stan-
dard star observations. Hence the Inst rument Response actor will not be executed, and the corre-
sponding interactive window will not appear. In Figure 7.0.6 we show what this interactive window looks
like. The usage and purpose of the Instrument Response interactive window are the same as for
the Spectrum Extraction interactive window which we describe in detail in the next few steps, and
so no more information on this window is given here in the tutorial.

Uves Interactive Instrument Response
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Figure 7.0.6: The interactive window for the Instrument Response actor.

14. Spectrum Extraction: InFigure7.0.7, we show the interactive window associated with the Spect rum
Extraction actor, which executes the UVES pipeline recipe uves_obs_scired. This pipeline
recipe performs the extraction of the science object spectrum using optimal extraction (Horne 1986),
automatically selecting an analytical spatial profile (Gaussian or Moffat) in the case of low S/N spec-
tra (S/N < 10) or an oversampled empirical spatial profile otherwise, and automatically determining the
degrees of the low-order polynomials involved in the extraction process. The top plot in the interactive
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Figure 7.0.7: The interactive window for the Spectrum Extraction actor for the first DataSet in the data
supplied with Reflex 2.0.
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Figure 7.0.8: Same as Fig. 7.0.7 but after iteration of the corresponding uves_obs_scired pipeline recipe.
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Figure 7.0.9: The interactive window for the Spectrum Extraction actor for the first DataSet in the data
supplied with Reflex 2.0 after iteration of the corresponding uves_obs_scired pipeline recipe and
rebinning to a resolution of 1 Ang.
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15.

window shows the extracted and merged spectrum of the science object (blue), and the plot below this
shows the flux-calibrated version. Error bars on the spectrum are plotted as 1-sigma limits in red.

Below the plots displaying the spectra are four smaller plots which show the S/N of the extracted spectrum
(upper-left), the spatial FWHM (upper-right), the “Ripple” parameter (lower-left), and the science object
position on the slit (lower-right), all as a function of the spectral order. The ripple parameter is a measure
of any systematic oscillations in the extracted spectrum, and should have values less than ~5 over all
orders to indicate that such oscillations are not present.

Use the buttons at the top of the interactive window to inspect these plots in detail, especially the extracted
spectra. For instance, you could zoom in on the absorption feature at 5412 Ang.

The current interactive window provides eight pipeline recipe parameters with the aim of allowing the
user to optimise the extraction for quality and S/N. Try to improve the spectrum extraction for the first
DataSet, based on the parameter descriptions that follow:

e reduce.extract.method - The method to be used for extracting the science spectrum, and
it may be set to optimal, average, or linear for our purposes. In most cases, the default
optimal extraction is the desired method.

e reduce.extract.kappa - The level of sigma-clipping to be performed when rejecting pixels
suspected of being contaminated by cosmic ray hits. The default value of 10.0 should be reduced to
smaller values (down to ~3.0) when an extracted spectrum shows sharp emission spikes that should
not be present

e reduce.extract.profile - The spatial profile model to be used when performing optimal
extraction, and it may be set to auto, virtual, gauss, or moffat for our purposes. The
default parameter value auto instructs the pipeline recipe to automatically decide on the type of
spatial profile model to employ based on the S/N of the science spectrum. Sometimes it is worth
testing the other spatial profiles that are available.

e reduce.extract.skymethod - The method for calculating the sky level may be set to one of
two values; namely opt imal or median. When set to opt imal, the sky level is included in the
optimal extraction model, and when set to median, the sky level is estimated via the median and
subtracted from the science spectrum before extraction. Sometimes the non-default median option
can give slightly better S/N than the default opt imal option.

e reduce.extract.oversample - The oversampling factor to be used in the empirical spatial
profile. When the empirical spatial profile is employed by the pipeline recipe, the oversampling
factor is set by default to 5 for S/N < 200, and to 10 for S/N > 200. Sometimes a larger value
for the oversampling factor may give a higher S/N extracted spectrum, especially for very high S/N
spectra.

e reduce.slitlength - This parameter may be used to control the slit length used to define the
spatial profile in the spectrum extraction. The default negative value instructs the pipeline recipe to
read the slit length from the science object FITS header. Setting this parameter to smaller values
than the slit length in the header may sometimes be useful in avoiding problems at the order edges,
with the disadvantage that the maximum achievable S/N will be smaller (less pixels involved in the
extraction).

e reduce.objoffset - This parameter may be used in conjunction with the parameter
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16.

17.

18.

19.

reduce.slitlength in order to extract the spectra of more than one object observed on the
slit in the same science image. Please see the section on “Optimal Extraction” in the chapter on
“Algorithms And Recipe Details” in the pipeline user manual (Larsen et al. 2012) for more details.

e reduce.rebin.wavestep - The rebinning step size in wavelength units for the extracted sci-
ence spectrum. The default negative value instructs the pipeline recipe to use the optimal resolution.
Setting this parameter to a positive value is useful for rebinning the spectrum to a lower resolution
while gaining a substantial increase in S/N. Hence this parameter is more concerned with spectrum
post-processing rather than extraction optimisation.

We find that for the first DataSet, setting reduce .extract.skymethod = median and
reduce.extract.oversample = 10, and leaving the other parameters at their default values,
increases the maximum spectrum S/N from 260 to 264 (see Figure 7.0.8).

For illustrative purposes, set reduce.rebin.wavestep = 1.0 Ang for the first DataSet, and re-
run the pipeline recipe. In Figure 7.0.9 we display the interactive window with the rebinned spectrum.
Notice that the S/N has been greatly improved at the cost of a lower resolution. Since the spectrum
rebinning is a post-processing operation, the S/N per order reported in the interactive window corresponds
to the S/N before rebinning.

Click the ] Continue wkf \ button in the interactive window.

As noted in the quick start Section 4, the workflow will write out the extracted spectrum and other im-
portant products to the end products directory (specified by the parameter END_PRODUCTS_DIR under
“Setup Directories” in the workflow canvas).

The workflow will now repeat the above reduction steps for the next DataSet, looping over each DataSet
until all of them have been processed. The other demo DataSets are provided to allow you to experiment
with optimising the reductions. We advise you to follow the above interactive procedures until you feel
that you have mastered the functionality of the pipeline parameters that are provided in the interactive
windows.
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8 Frequently Asked Questions

o Where are my intermediate pipeline products?

Intermediate pipeline products are stored in the directory <TMP_PRODUCTS_DIR> (defined on the
workflow canvas) and organised further in directories by pipeline recipe.

I have many DataSets in my data directory. How can I reduce them interactively without having to
wait a long time between interactive windows being displayed?

Reduce all the DataSets at once with the interactive windows disabled for all interactive actors. When
this reduction has finished, you should re-enable the interactive windows that you require, and run the
workflow again. The workflow will run in Lazy mode and no time will be spent on pipeline reductions,
unless you specifically change a parameter in one of the interactive windows.

Note that Lazy mode will not work if the workflow parameter EraseDirs is set to true.

Can I use different sets of bias frames to calibrate my flat frames and science data?

Yes. In fact this is what is currently implemented in the workflow(s). In Section 6.3.1 of this document,
we have described the concept of purpose which is attached to each file in a DataSet. It is this purpose
that is used by the workflow to send the correct set of bias frames to the recipes for flat frame combination
and science frame reduction, which may or may not be the same set of bias frames in each case.

How can I add new actors to an existing workflow?

You can drag and drop the actors in the menu on the left of the Ref1ex canvas. Under Eso-reflex ->
Workflow you may find all the actors relevant for pipeline workflows, with the exception of the recipe
executer. This actor must be manually instantiated using Tools -> Instantiate Component.
Fill in the “Class name” field with org.eso.RecipeExecuter and in the pop-up window choose
the required recipe from the pull-down menu. To connect the ports of the actor, click on the source port,
holding down the left mouse button, and release the mouse button over the destination port. Please consult
the Reflex User Manual (Forchi 2012) for more information.

How can I broadcast a result to different subsequent actors?

If the output port is a multi-port (filled in white), then you may have several relations from the port.
However, if the port is a single port (filled in black), then you may use the black diamond from the
toolbar. Make a relation from the output port to the diamond. Then make relations from the input ports to
the diamond. Please note that you cannot click to start a relation from the diamond itself. Please consult
the Reflex User Manual (Forchi 2012) for more information.

How to move a Reflex window if it is bigger than the display?

That depends on your window manager/desktop. For some window managers one can use Alt+left mouse
button to drag the window around desktop.
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9 Troubleshooting
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Figure 9.0.10: TheDataOrganizer interactive window reports an error “:No Datasets have been created, check
the DataSet and the OCA rules.”.

1. I downloaded the data from the ESO archive, put them into a new directory, tried to run Reflex
on them, but

(a)

(b)

(©

it crashes

This may happen if one of the files was downloaded only partially (check for a file with the extension
fits.Z.part. You will have to download that file again in order to have an uncorrrupted file (and
remove the partial one).

it fails with error message ‘“:No DataSets have been created, check the data set and the OCA
rules.”’(see Figure 9.0.10.)

This error may be due to the fact that the data provided by the ESO archive are compressed
(<filename>.fits.Z). Please remember to uncompress the data before executing Reflex.
all DataSets are greyed out in the DataSets interactive window.

The ESO archive used with CalSelector does not always supply all static calibration files. As a
consequence some/all DataSets are greyed out because they were missing such required data.

Missing static calibration should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal.

2. I downloaded the data from the ESO archive and put them into a new directory, tried to run
Reflex on them, but all DataSets are greyed out in the DataSets interactive window.

The ESO archive does not supply as default general calibration files such as the LINE_REFER_TABLE.
As a consequence all DataSets are greyed out because they were missing such required data.

The user may solve this problem remembering that any reference data file required for the data reduction
is also provided by the pipeline distribution kit.

3. I have only DFLATS for a given DataSet, which is shown as incomplete by the DataSetChooser. Is
there support for this setup?

Yes, there is support. Use the Uves_dflats.xml workflow instead of the usual Uves . xm1 workflow.
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4. The workflow reports to me that there are no DataSets in my data directory. How can this be?

Remember that the UVES workflow supports data for point source observations only. It is possible that
your data consists entirely of extended source, image slicer, or multi-object spectrograph observations, in
which case the Data Organiser actor will not construct any DataSets.

. The “Select Datasets” window displays my DataSets, but some/all of them are greyed out. What is
going on?

If a DataSet in the “Select Datasets” window is greyed out, then it means that the DataSet that was con-
structed is missing some key calibration(s) (i.e. the DataSet is incomplete). To find out what calibration(s)
are missing from a greyed out DataSet, click on the DataSet in question to highlight it in blue, and then
click on the button Inspect Highlighted. The “Select Frames” window that appears will report
the file category of the calibration(s) that are missing.

. When I click on the “Configure subplots’ button in the interactive window (see Section 7, step 6),
the window that appears is empty. Can this be corrected?

This is a known problem that will addressed in future releases.
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